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Safety Instructions

Before starting the experiment, students must be familiar with the laboratory regulations. A
printed version of the regulations can be found next to the laboratory entrance. In particular,
the following sources of hazard will be encountered during the course:

Nitrogen dioxide cuvette

For parts of the experiment a nitrogen dioxide (NO2) cuvette with an NO2 volume mixing
ratio between 0.5 and 1.0% will be used. NO2 is harmful by inhalation. In case of nausea or
respiratory tract irritation call a poison control center or doctor. In case of release of gas from
the cuvette immediately leave the room and open windows if possible. Inform your experiment
supervisor. Storage may only be carried out in well-ventilated areas. The cuvette must therefore
be returned to an appropriate room after completion of the experiment.

Ethanol solution

Occasionally ethanol solution has to be applied to clean the optics in the telescope. Inhalation,
eye and skin contact should be avoided. When working with it, wear protective gloves and eye
protection. Keep the container away from any source of ignition and keep it tightly closed,
if not in use. In case of contact with eyes, flush them with water for a few minutes. After
swallowing drink plenty of water, then seek medical advice immediately.

Ultra violet (UV) radiation

In this experiment, a UV light source is used. UV radiation irritates and damages the eyes.
Skin irritation and even severe burns can occur in case of continuous UV exposure. When
working with the lightsource wear appropriate protective goggles. Do not look directly into the
light. Avoid direct exposure of the skin. If possible, screen the optical setup. Do not use the
light source longer than necessary.

Details on the listed hazards can be found in the information sheets attached to the labo-
ratory regulations. By signing the ’Safety Briefing - Signature List’, you confirm, that you have
read and understood these instructions.
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Introduction

Differential Optical Absorption Spectroscopy (DOAS) is a widely used technique for the detec-
tion of atmospheric trace gases in the atmosphere. It is based on the wavelength dependent
absorption of light by atmospheric constituents. Various trace gases can be identified simultane-
ously by their spectral signatures which act as an individual ’fingerprint’. The DOAS technique
has been implemented on several platforms: from ground, on aircrafts, balloons and satellites,
and by using either artificial light sources, scattered sunlight or direct sun- or moonlight.
Ground-based DOAS observations of scattered sunlight is very suitable both for long term mea-
surements of atmospheric constituents, and for measurements in the field using small portable
instruments. The latter can be used, for example, to study emissions from volcanic plumes or
the emission of reactive trace gases from remote salt lakes. Since those instruments are easy to
maintain, they are ideally suited for the operation in remote regions with restricted technical
infrastructure.
This experiment offers the opportunity to gain insight into spectroscopic remote sensing tech-
niques, which are widely used to study the composition of the Earth’s atmosphere. Differential
optical absorption spectroscopy has been developed by U. Platt and D. Perner at the Institute
of Environmental Physics of the University of Heidelberg. A relatively new application of this
measurement technique is Multi-Axis DOAS (MAX-DOAS), which has an enhanced sensitivity
for trace gases near the surface and allows to gain information on their vertical distribution.
The topics covered by this experiment are:

� To gain insight in the chemistry of the troposphere and stratosphere, in particular re-
garding ozone and NO2

� To become familiar with spectroscopy and spectroscopic analysis techniques

� To gain insight into the radiative transfer in the Earth’s atmosphere

� To learn how to determine a trace gas concentration with DOAS

Instrumentation:

� Passive DOAS instrument with spectrograph/detector unit

� Quartz fiber

� Temperature regulator

� Halogen lamp

� Mercury vapor lamp

� Computer with measurement and analysis software

� Glass cell filled with NO2

II



Study guide

Before starting the experiment, please take the time to review these materials. While you do
not need to know the exact step by step procedure of the experiment, you should be able to
answer the following questions:

� How are ozone and nitrogen dioxide (NO2) distributed in the atmosphere? What are
typical concentrations of these species? How do the concentrations vary with the time of
day?

� What is the importance of ozone in the stratosphere? What is the ozone hole? How is it
formed?

� What is the importance of ozone and NO2 in the troposphere?

� What is the Beer-Lambert law of absorption? What does it describe?

� What does the word differential mean in Differential Optical Absorption Spectroscopy
(DOAS). Why is absolute absorption spectroscopy difficult to apply in the atmosphere?

� What components contribute to a measured spectrum?

� What equipment is necessary to record an atmospheric spectrum and why?

� What is a slant column density (SCD)? What is a vertical column density (VCD)?

� What knowledge is required in order to calculate trace gas concentrations from SCDs?

� What is a Langley Plot? What is it used for?

� What is Multi-Axis DOAS (MAX-DOAS)? How can information about the vertical profile
of a trace gas species be obtained with this technique?

III
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Chapter 1

Background Information

1.1 The atmosphere

An atmosphere1 is a gas cover surrounding a star or a planet due to its gravitation. In the
following, we will only discuss the earth’s atmosphere. The atmosphere can be divided into
layers. The most common classification is linked to the temperature. According to this scheme,
the atmosphere is divided into the troposphere, the stratosphere, the mesosphere, the thermo-
sphere and the exosphere. The regions dividing two layers are called ’pause’, as in tropopause.
In the troposphere, the energy flow is dominated by incoming solar radiation heating up the
surface (Fig. 1.1). Sensible2 and latent3 heat are then transported from the ground up into the
troposphere, and thermal energy is converted into potential energy. The updraft of an airparcel
from the ground can be approximated by adiabatic cooling, which explains the temperature
decline of 6-10 K per km. This transport of latent heat drives the weather in the troposphere
and explains its turbulent behaviour. On the other hand, the energy balance in the stratosphere
is dominated by radiative heating due to absorption of incoming radiation by trace gases, for
example ozone. This leads to an increase of temperature with altitude and thus a stratification
of the airmasses, hence the term ’stratosphere’.

1.2 Measurements and dimensions

The concentration of a trace gas is the number of molecules in a volumetric unit. Its dimension
is typically [Molecules/cm3] or [µg/m3].

The mixing ratio is the relative amount of a trace gas as compared to the amount of air. The
units [ppm], [ppb] and [ppt] are common. Usually, the quantity is related to the volume ratio,
so the units are sometimes written as [ppmv], [ppbv], or [pptv].

For DOAS measurements, the column density plays an important role. This is the concentration
of a species integrated along a light path

∫
ρ(s)ds, and is typically given in molecules/cm2.

The vertical column density gives the amount of molecules of a certain substance in the entire
atmosphere over a square centimeter on the ground. For ozone, the Dobson Unit [DU]4 has
become popular. 100 DU correspond to a vertical ozone column of 1 mm at 0°C and 1013.25
hPa. Typical vertical ozone columns in the atmosphere are between 300 and 400 DU. Therefore,

1Greek atmos = haze
2thermal energy that can be measured with a thermometer
3Energy originating from evaporation on the ground or in the ocean.
41DU = 2,6·1016 Molecules/cm2
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1.3. COMPOSITION OF THE AIR 3

Figure 1.1: Global annual mean energy budget. [30]

the total ozone in the atmosphere corresponds to a layer with 3-4 mm thickness when brought
to normal conditions.

1.3 Composition of the air

The main constituents of the air are oxygen, nitrogen and argon (see table 1.1). Water vapor can
have concentrations of between 0.02 % and 2.5 % in the troposphere. In the stratosphere, the
mixing ratio of water vapor is only about 3 - 4 ppm. All other gases together make up only 0.04
%, and are therefore called trace gases. Regarding the stable main constituents, the atmosphere
is well mixed and the number concentrations are basically proportional to the atmospheric
pressure profile. In first approximation, atmospheric pressure decreases exponentially with
altitude, approximately with a surface pressure of 1013 hPa and a scale height of 8 km. In
contrast to the main constituents, trace gas concentrations are significantly affected by complex
production and destruction cycles and may therefore vary strongly within space and time.

O4

The O4 molecule is the dimer of the oxygen molecule O2. It can be formed when two oxygen
molecules collide. Therefore, its concentration is proportional to the square of the oxygen
concentration in the atmosphere. For this reason, its column is given in molecules2/cm5. Its
vertical profile is an exponential decrease with altitude with a scale height of approximately
4 km. Because the vertical profile of O4 concentration is well known, the measured column
densities can be used to gain insight into photon paths in the atmosphere, i.e. light path
enhancement due to aerosols and clouds [33].



4 CHAPTER 1. BACKGROUND INFORMATION

Figure 1.2: Atmospheric temperature profile and layering.

Gas Symbol Volume Fraction

Nitrogen N2 78,08%
Oxygen O2 20,95%
Argon Ar 0,93%
Water vapor H2O ca. 1%
Carbon Dioxide CO2 358 ppmv
Neon Ne 18,2 ppmv
Methane CH4 1,75 ppmv
Krypton Kr 1,14 ppmv
Hydrogen H2 0,55ppmv
Nitrous Oxide N2O 0,31 ppmv
Carbon Monoxide CO 0,11 ppmv
Ozone O3 0,04 ppmv
Chloroflourocarbons (CFCs) (2,8 - 4,8)·10−4 ppmv

Table 1.1: Chemical composition of the atmosphere at sea level.



Chapter 2

Atmospheric chemistry I:
Stratospheric ozone

2.1 The importance of ozone in the stratosphere

The ozone molecule is composed of three oxygen atoms: O3. In its gas phase, it is light blue. At
-111.9 °C, it condensates to an explosive, dark blue, magnetic liquid. At -192.5 °C, it crystalizes
to a dark violet mass. The dissociation at room temperature is slow, while it occurs explosively
if heated.
The average lifetime of an ozone molecule at 25 km altitude is about 1 hour. This lifetime is
determined by the photolysis frequency of ozone. However, the ozone concentration of a given
airmass changes slowly with time, as most oxygen atoms originating from ozone photolysis
quickly react back to ozone (see section 2.2). Therefore, it usually takes months or years to
significantly change the ozone concentration in a given airmass. This stands in contrast to the
quick reduction seen in the ozone hole formation discussed in section 2.2.4.
Ozone is a highly efficient absorber of UV radiation. Even though it is present only in such
small concentrations, it blocks a large part (95-99%) of the harmful (λ < 320 nm) UV radiation
at an altitude of 20 to 50 km. Therefore, the ozone layer is of great importance for life on earth.
The largest absorption of ozone occurs between 240 nm and 310 nm, as can be seen in figure
2.1.

Figure 2.1: Spectrum of incident solar radiation at the top of the atmosphere and at sea level.

5



6 CHAPTER 2. STRATOSPHERIC OZONE

2.1.1 Vertical profile of ozone concentration

About 90% of the total ozone column is found in the stratosphere, the rest in the troposphere.
In mid latitudes, the ozone concentration at the ground is about 1·1012 molec/cm3, while typical
concentrations in the stratosphere are 1·1013 to 2 ·1013 molec/cm3 (see figure 2.2, left panel).
The vertical profile of ozone is determined by the number of UV photons and the decreasing
number of oxygen molecules in the upper atmosphere. At high altitudes, the air is so thin
that the UV photons barely ever hit oxygen molecules and no atomic oxygen is formed. As
the density of the air increases with lower altitudes, the probability for O2 photolysis increases,
and the O3 mixing ratio follows this trend. The lower end of the ozone layer is reached, when
no more UV photons necessary for the formation of O3 are available, as they have all been
absorbed in higher layers.

Figure 2.2: Left: Ozone concentration vertical profile. Right: The enhancement of harmful UV
radiation is exponential with decreasing ozone columns, as described by the Beer-Lambert law of
absorption. This plot shows data measured in Antarctica between February 1991 and December
1992.

2.1.2 The effects of harmful UV radiation

The energy of shortwave UV radiation with wavelengths below 320 nm is enough to destroy
molecules, proteins and amino acids, which are the main constituents of organic matter. En-
hanced UV radiation directly increases the risk of skin cancer and biological mutation, and has
even been shown to directly influence marine biology and agriculture (see e.g. [12, 28, 29, 35]).
A decreasing ozone column in the stratosphere enables more UV radiation to reach the earth.
This relationship is not linear, as shown in figure 2.2, right panel.

2.2 Photochemistry of ozone in the stratosphere

2.2.1 Chapman cycle

Sidney Chapman [3] published the first simple theory about ozone in the stratosphere in 1930.
He postulated the ozone to be the result of a chemical equilibrium of 4 photochemical reactions.
At altitudes between 20 and 25 km, atomic oxygen is formed from the photolytical splitting of
oxygen molecules by shortwave UV radiation (λ < 242 nm).

O2 + hν → 2O (2.1)
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Ozone is then formed by the recombination of the atomic oxygen with molecular oxygen.

O2 +O+M → O3 +M (2.2)

M is a chemically neutral molecule (e.g. N2 or O2) needed for conservation of momentum.
To reach an equilibrium ozone concentration, ozone destruction reactions are also necessary.
Chapman held the photolytic dissociation (λ < 1100nm) of ozone responsible:

O3 + hν → O2 +O(3P) (2.3)

The formed oxygen atoms then either react according to equation 2.2 and form ozone again, or
they destroy an additional ozone molecule:

O3 +O → 2O2 (2.4)

These four reactions comprise the Chapman cycle. Chapman’s theory was correct, but the
measured ozone columns where always lower than his predicted ones, usually by about 40%.
Also, the height of the ozone maximum was incorrect.

2.2.2 Catalytic ozone destruction

Today we know that catalytic reactions1 involving radicals of the groups HOx (H, OH, HO2),
NOx (NO, NO2) ClOx (Cl, ClO) and BrOx (Br, BrO) play a very important role in the destruc-
tion of ozone. The catalysts X greatly accelerate the ozone destruction previously mentioned
in equation 2.4.

X + O3 → XO + O2

XO + O → X + O2

Netto: O + O3 → O2 + O2

As catalysts are not removed from the cycle, they are available for further ozone destruction.
HOx and NOx can cycle through this reaction scheme 1000 to 10000 times before they are
removed from the atmosphere by chemical reaction or sedimentation. Because these reactions
are much faster than the reaction of O3 with O, the catalysts have a very strong influence on
stratospheric ozone chemistry, lowering the ozone concentrations when compared to the values
predicted by Chapman. By taking these catalytic reactions into account it was for the first time
possible to match predicted and measured vertical ozone profiles (see figure 2.3, left panel).

2.2.3 Anthropogenic influence on the total ozone column

Since the mid 80s, the average global total ozone columns have been decreasing. The total ozone
decrease after considering natural variations is about 5% per decade. This decrease can be seen
in mid latitudes, and is not restricted to the regions over Antarctica victimized by the ozone
hole (see section 2.2.4). The right panel of figure 2.3 shows the decrease in ozone after removing
all known natural variations from the trend. Ozone destruction by CFCs was detectable as early
as 1974. These gases are industrially produced compounds containing carbon (C), fluorine (F)
and chlorine (Cl). They found widespread use as cooling agents and gas propellant in spray
cans by the 1950s. CFC molecules are chemically inert in the lower troposphere, however upon
reaching the upper area of the ozone layer in about 30km altitude, CFCs are photolyzed by

1Catalytic reactions are reactions that are controlled by a certain substance, the so-called catalyst. The
catalyst itself is not changed by the reaction.
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Figure 2.3: Left: The Chapman cycle alone predicts ozone mixing ratios approximately twice
as high as the measured values. Only by taking the catalytic ozone destruction into account the
measurements could be understood. Right: Decrease in global ozone after removing all known
natural variations.

shortwave UV radiation. The chlorine concentration of the atmosphere was increased by a
factor of 6 within a few decades by this process.
By the mid-1980s, scientists realised the influence of CFCs on ozone destruction. In 1987,
the industrialized nations signed the Montreal Protocol to reduce CFC emissions, followed by
several additional treaties thereafter. Figure 2.4 shows the global CFC production between
1986 and 1996.
Because of the long lifetimes of CFCs in the atmosphere (up to 100 years for some species), they
continue to act as catalysts in ozone destruction even though emissions have been drastically
reduced. In very recent years, the measured ozone hole has seemed to decrease in size and
intensity. However, it will still take several decades for the ozone layer to recover.2

Figure 2.4: Global CFC production by year for industrialized and developing nations.

2.2.4 The Ozone hole

In the middle of the 1980s, a maximum ozone loss of approximately 10% was predicted by
scientists due to destruction by CFCs. In October 1984, however, more than 40% of the ozone
in the ozone layer above Antarctica was destroyed. At the end of August, the ozone column

2for details: Scientific Assessment of Ozone Depletion, WMO, 2010 at www.wmo.int

www.wmo.int


2.2. PHOTOCHEMISTRY OF OZONE IN THE STRATOSPHERE 9

over Antarctica decreases rapidly and reaches a minimum in September. In November, the
values increase back to normal levels. Ozone is destroyed only in the altitude range between
12 and 30 km, as shown in figure 2.5. However, this is also where the ozone layer is normally
located. These findings could not be explained by dynamic processes alone. Instead, a complex
chemical mechanism was found to be responsible.

Figure 2.5: Left: Altitude profile of the ozone concenration measured over Antarctica in August
1997 and October 1997. Right: Time series of the annual minimum of the measured ozone
column density.

Chlorine and bromine reach the polar stratosphere in the form of transport-gases such as CFCs.
Here, they react to so-called reservoir gases. Chlorine and bromine are bound in these gases
and are removed from ozone destroying reactions. During the polar night, two processes then
combine to release the halogens. For one, a polar vortex forms in the stratosphere. Tropical
air masses are transported towards the poles and are deflected by the coriolis force. The large
temperature gradient present in the Antarctic winter from July to October causes the air to swirl
around the south pole in a stable stratospheric vortex, effectively shielding the south pole from
other adjacent air masses. In the absence of sunlight, the air in the Antarctic stratosphere then
cools to temperatures around -80 °C. At these very low temperatures, a second phenomenon
takes place. So-called Polar Stratospheric Clouds (PSC) are formed from ice, nitric acid and
some sulfuric acid. The extreme conditions necessary to form such clouds are only present
during the Antarctic winter in the absence of sunlight in altitudes between 15 and 25 km.
Once formed, the PSCs very effectively activate halogens through the following heterogeneous
reactions taking place on the ice surfaces.

XONO2 +H2O → HNO3 +HOX (2.5)

XONO2 +HX → HNO3 +X2 (2.6)

X = Cl, Br.
Without the PSC-surfaces, these reactions would be very slow and therefore irrelevant. When
the sun now goes up in the Antarctic spring, the activated halogens act very effectively as
catalysts for ozone destruction. In the Arctic, the distribution of land masses prevents forming a
very strong polar vortex, therefore Arctic ozone hole is much less pronounced than the Antarctic
version. If all conditions remain the same, the ozone layer should recuperate by the middle of
the coming century. However, some aspects are still poorly understood. For example, when
ozone absorbs UV radiation, it heats the stratosphere. Ozone depletion therefore leads to a
cooling trend in the stratosphere, which could lead to an increased abundance of PSCs and
therefore even stronger ozone destruction. These and other questions are still being explored
to date.



Chapter 3

Atmospheric chemistry II:
Nitrogen oxides

The Nitrogen oxides NO (nitric oxide) and NO2 (nitrogen dioxide) are together referred to as
NOx. They are one of the most problematic pollutants in urban areas not only in developing,
but also in industrialised countries. They are key species in the control of tropospheric ozone
production and by this play an important role in the formation of the so called ”Los Angeles
Smog” (see section 3.4). Moreover, the concentration of NOx has a strong influence on the
atmospheric level of hydroxyl radicals (OH), which initiates the degradation of most oxidizable
trace gases [7].

3.1 Health aspects of NO2 air pollution

Nitrogen dioxide is a brown, toxic gas: Mixing ratios over 20 ppm cause strong irritations of the
respiratory system including tickling of the throat, headaches, dizziness and eventually nausea.
At higher mixing ratios, it can lead to death (700 ppm after 30 minutes will be lethal). Inhaled
gas together with the humid mucosae creates nitric acid, which causes strong degradation of
the lungs capillaries (Air Liquide EG-safety data sheet). In addition to being a health hazard in
itself, NO2 is a precursor of a number of harmful secondary pollutants, including the formation
of inorganic particulate matter via HNO3, and photo oxidants (e.g. ozone and PANs1). These
relationships are shown in figure 3.1.

Figure 3.1: Simplified relationship of NOx emission with formation of NO2 and other harmful
reaction products including O3 and particulate matter (PM2.5) [36].

1peroxyacyl nitrates

10
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3.2 Sources and sinks of tropospheric NOx

The global emissions of NOx are caused by both human activities and natural processes. Table
?? shows the sources of NOx and their contribution to the global emissions. New highly resolved
satellite measurements allow to determine the global distribution of these NOx sources. Figure
3.2 depicts the 18 month mean of a satellite measurement of NO2, which was recorded by
the SCIAMACHY instrument aboard the ESA satellite ENVISAT. Areas with high vertical
column densities correlate with urban areas and therefore anthropogenic sources. In fact more
than half of the global NOx emissions are man made. The major source of anthropogenic NOx

is the combustion of fossil fuels in industrial processes, power plants and traffic. The most
important mechanism for natural and anthropogenic production of NOx is the Zel’dovic cycle
[38] which describes the formation of thermal NO. The term thermal is chosen due to the
high activation energy necessary for reaction 3.2 of 318 kJ/mol. Therefore, NO is emitted from
combustion processes, e.g. in combustion engines (traffic) and from thermal power plants or
other industrial combustion processes.

O2 +M → O+O+M (3.1)

O + N2 ⇔ NO+N (3.2)

N + O2 ⇔ NO+O (3.3)

N + OH ⇔ NO+H (3.4)

Afterwards, NO2 can be produced via reaction 3.7. NOx is removed from the atmosphere mainly
by further oxidation. During the day hydroxyl radicals oxidize NO2 to nitric acid, which is then
removed from the atmosphere by wet (acid rain) and dry deposition:

NO2 +OH+M −→ HNO3 +M (3.5)

Another sink of NOx is the reaction of NO2 with ozone. Although the rate coefficient for this
reaction is relatively small, it cannot be neglected in areas with high ozone concentrations in
the absence of sunlight. During daytime this reaction plays no role because NO3 is rapidly
photolyzed. During the night, NO3 reacts with NO2 to form the anhydrite of nitric acid N2O5.
The major sink of tropospheric N2O5 is the hydrolysis and subsequent wet or dry deposition
[19].

3.3 Photostationary state with ozone

Nitrogen dioxide is mainly a secondary pollutant. The oxidation to NO2 is explained by [16].

O(3P) + O2 +M −→ O3 +M (3.6)

O3 +NO ⇐⇒ NO2 +O2 (3.7)

NO2 + hν (λ < 410 nm) −→ NO+O(3P) (3.8)

Photolysis in reaction 3.8 does only occour at wavelenghts below 410nm. The third reaction
partner in 3.6 is required due to momentum conservation. The steady state concentrations of
O3, NO and NO2 are linked by the Leighton ratio:

[NO]

[NO2]
=

jNO2

kO3+NO · [O3]
(3.9)

kO3+NO is the reaction constant for eqn. 3.7. Since the photolysis rate changes with solar zenith
angle the Leighton ratio also changes during the course of the day. On a clear day, at noontime,
when the photolysis rate has its maximum of about jNO2 ≈ 8× 10−3 s−1 the Leighton ratio has
its maximum and the lifetime of NO2 is about 2min. At typical O3 mixing ratios of 30 ppb,
[NO]
[NO2]

is on the order of 1.
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Figure 3.2: Satellite measurement of the NO2 vertical column densitiy averaged over the time
period from January 2003 to June 2004. The measurements have been performed with the
SCIAMACHY instrument aboard the ESA satellite ENVISAT. [1].

3.3.1 NO2 Diurnal Cycle

In an atmosphere that is free of volatile organic compounds (VOCs), NO2, NO and O3 are in a
self contained diurnal cycle, which is strongly dependent on the sun’s UV light. In the morning,
the intensity of solar light increases. This leads to photodissociation of NO2. But during the
day, NO and NO2 are in a photostationary balance (see reactions 3.6-3.8).
For the stratosphere, the mixing ratio of NO2 increases during the day, due to the dissociation
of N2O5 to NO2.

N2O5 + hν → NO2 +NO3 (3.10)

NO3 splits up rapidly to NO2 or NO. This only happens during the daytime.

NO3 + hν → NO+O2 (3.11)

NO3 + hν → NO2 +O (3.12)

In the evening, the photolysis decreases and reaction 3.8 no longer creates NO. The result is
an increase of NO2. At night NO2 forms N2O5 again.

NO2 +O3 → NO3 +O2 (3.13)

NO3 +NO2 +M → N2O5 +M (3.14)

3.4 Photochemical smog / deviation from the photosta-

tionary state

Since the first reports of photochemical smog in Los Angeles in the late 1940’s, extremely high
ozone levels have been measured in urban areas throughout the whole world. In Mexico City
ozone levels over 400 ppb have been reported. Photochemical smog is worst when high levels
of volatile organic compounds (VOCs) and NOx are emitted into a thermal inversion layer,
trapping them closely to the ground, and irradiated by sunlight during transport to downwind
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Figure 3.3: Reaction cycles of tropospheric NOx and ozone in a polluted atmosphere. The
photostationary state of NOx is illustrated by the blue cycle. It is disrupted by the presence of
VOCs, which results in a net production of ozone. [31].

regions. This section discusses the mechanisms responsible for the creation of photochemical
smog.

The Leighton relation is only valid if reactions 3.6-3.8 describe the major sources and sinks of
NO2 and O3. In the presence of VOCs, another reaction path for the conversion of NO to NO2

exists, without the destruction of O3. The OH radical which usually initiates the reaction chain
is mainly formed by means of ozone photolysis:

O3 + hν (λ < 320 nm) −→ O(1D) + O2 (3.15)

O(1D) + H2O −→ 2OH (3.16)

The reaction chain is started by the oxidation of a hydrocarbon (RH) which may be described
as

RH + OH −→ R+ H2O (3.17)

R + O2 −→ RO2 (3.18)

The peroxy radicals (RO2) and (HO2) react with NO and produce NO2 without destroying
ozone (see e.g. [2, 4, 20])

RO2 +NO −→ NO2 +RO (3.19)

RO + O2 −→ R′CHO+HO2 (3.20)

HO2 +NO −→ NO2 +OH (3.21)
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This scheme can be applied multiple times until the initial VOC is converted to CO2 or CO
and H2O. Together with the reactions from 3.6-3.8 this can be written as an effective equation
for the ozone production:

RH + 4O2 + 2hν(λ < 410 nm) −→ R′CHO+H2O+ 2O3 (3.22)

The reaction system is illustrated in figure 3.3 together with the most important sources of
OH, hydroxyl and peroxy radicals.



Chapter 4

DOAS

Differential Optical Absorption Spectroscopy is a widely used technique in atmospheric research
for the detection of numerous trace gases, such as ozone, NO2, formaldehyde, halogen radicals
(BrO, IO), water vapour, and many others [21, 22].

4.1 The Lambert-Beer Law

When electromagnetic radiation passes through matter, its intensity is reduced by absorption
and scattering. This process, called extinction, is described by the law of August Beer.

�

Figure 4.1: Light with the initial intensity I0(λ) is emitted by a light source. After passing
through a volume of air containing an absorber with concentration ρ, the detector measures the
reduced intensity I(λ).

Let I0(λ) be the intensity of a light beam at wavelength λ before entering the absorber, and
I(λ, L) the intensity after passing a layer of length L. Then the relationship between incident
and transmitted intensity is

I(λ, L) = I0(λ) · exp(−σ(λ) · ρ · L) (4.1)

with σ being the absorption cross section and ρ the concentration of the trace gas. In general,
σ depends on pressure and temperature along the light path. Furthermore, the concentration
along the light path can vary. The Lambert-Beer law describes the absorption for n different
absorbers i:

I(λ, L) = I0(λ) · exp

(
−
∫ L

0

n∑
i=1

σi(λ) · ρi(s)ds

)
(4.2)

4.2 The DOAS method

To determine the concentration of a particular trace gas in the atmosphere, it would, in prin-
ciple, be necessary to quantify all factors influencing the intensity I(λ) of a spectrum of light.

15
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In the laboratory, this can be achieved by removing the absorber from the light path. In the
atmosphere, however, where this is impossible, the multiple factors influencing the intensity
pose a dilemma. DOAS overcomes this challenge by using the fact that many processes in
radiative transfer show broad or even smooth spectral characteristics, while certain trace gases
exhibit narrowband absorption structures. The basic principle of DOAS is thus the separa-
tion of spectral structures in narrowband (varying strongly with wavelength) and broadband
components (varying slowly with wavelength) in differential spectra, so that changes in nar-
rowband absorptions can be detected (illustrated in figure 4.4). To use equation 4.2 in DOAS
measurements, it therefore has to be modified according to properties of radiative transfer in
the atmosphere and the measurement principles of DOAS instruments.

4.2.1 Narrowband components

Fraunhofer reference spectrum

The sun’s spectrum is highly structured (see figures 2.1 and 4.3, top). These structures must
be taken into account in a DOAS retrieval when using a passive instrument, i.e. when using
the sun as a light source. This is usually achieved by using a so-called Fraunhofer reference
spectrum I0, which is a solar spectrum recorded under conditions in which the trace gases to
be investigated show little or no absorption.

Trace gas absorption

The primary quantity measured by DOAS instruments is the slant column density (SCD or S),
defined as the integrated concentration ρ of a trace gas i along the light path of length L:

SCD = Si(λ) =

∫ L(λ)

0

ρi(s)ds (4.3)

Each trace gas has its individual absorption cross section σi which serves as a spectral finger-
print. Several absorbers can be measured simultaneously even if their absorption features are
superimposed (see figure 4.2). By fitting these cross sections to recorded differential spectra,
SCDs are retrieved. If the Fraunhofer reference spectrum already contains absorption of a trace
gas, the SCD is often called differential Slant Column Density (∆SCD or ∆S ).

The Ring Effect

In 1961, J. Grainger and J. Ring [11] discovered that the the depth of the Fraunhofer lines
was smaller when examining scattered sunlight than when direct sunlight is observed. This was
attributed to inelastic rotational Raman scattering [32], which slightly changes the wavelength of
the scattered photon when the scattering occurs. This causes a ”filling in” of strong absorption
lines, as wavelengths on either side of the line are shifted into it. The magnitude of the so-called
Ring effect depends on the atmospheric path lengths of the photons entering the spectrometer.
The longer the path in the lower atmosphere where the air density is higher, the more likely
a Raman scattering event becomes. Therefore, the Ring effect is dependent e.g. on the solar
zenith angle, the cloud cover and the aerosol concentration in the atmosphere. To correct for
the Ring effect, a so-called Ring spectrum R(λ) is calculated (e.g. by DOASIS, figure 4.3).
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Figure 4.2: UV/Vis absorption cross sections of atmospheric trace gases detectable by DOAS.

4.2.2 Broadband components

The light is affected by scattering and absorption on aerosol particles and cloud droplets (Mie
scattering) and by scattering on air molecules (Rayleigh scattering)1. The sum of both effects,
scattering and absorption, is referred to as extinction, εM and εR respectively. Both processes
εM and εR are elastic, i.e. the wavelength of the scattered photons remains constant during
the process. The Rayleigh scattering probability is proportional to λ−4, so shorter wavelengths
are more likely to be scattered than long wavelengths. This is the reason why the sky appears
blue. Mie scattering is much less dependent on wavelength, so clouds and fog appear white, as
all wavelengths are equally scattered.
For the sake of integrity it should be noted that some trace gas cross sections also have broad-
band parts σi0(λ) in addition to the narrowband parts mentioned above.

1More precisely, we mean the Cabannes line of Rayleigh scattering. In a strict nomenclature, Rayleigh
scattering also includes rotational Raman lines (mentioned above), but these are treated separately in the
DOAS approach because of their effect on narrowband spectral structures. For clarity, see [37].
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Figure 4.3: An example of a Fraunhofer spectrum (top) and the Ring spectrum calculated from
it (bottom).

4.2.3 Modified Lambert-Beer Law

Considering sections 4.2.1 and 4.2.2, we expand equation 4.2:

I(λ, L) = I0(λ) · exp

(
−R(λ)−

∑
i

σi(λ) · Si(λ)

)
· (4.4)

exp

[
−L ·

(∑
i

(σi0(λ) · ρi) + εR(λ) + εM(λ)

)]
Here, the first exponent contains all narrowband components and the second exponent contains
all broadband components. The separation of narrow and broadband absorption is illustrated
in figure 4.4 and the optical density is defined in the following section.

Figure 4.4: The principle of DOAS: The optical density τ is the result of narrow σi and broad-
band parts σi0 of an absorption cross section. Adapted from [22].
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4.2.4 The DOAS fit

Solving equation 4.4 for ln(I/I0) yields the optical density τ :

τ = ln

(
I(λ)

I0(λ)

)
(4.5)

= −R(λ)−
∑
i

σi(λ) · Si(λ)−
∑
k

bkλ
k

Here,
∑

bkλ
k is a polynomial to account for the second exponent of equation 4.4, which includes

all broad band features, as mentioned in section 4.2.2. R(λ) is the Ring spectrum and σi(λ)
and Si(λ) are the cross section and the slant column density of trace gas i, respectively. Apart
from atmospheric effects, the instrument itself also modulates the signal: The signal from light
reflected from elements in the spectrometer or the 0th or 2nd order of scattering from the
grating are called spectrometer stray light. If stray light intensity varies over the spectrum,
absorption bands at different wavelengths will be changed differently, i.e. the optical density
will be reduced more for some parts of the spectrum than for others. In order to account for
this, a so-called ’Offset’ polynomial IOfs(λ) can be added in the fitting procedure (see equation
4.6).

The idea of the DOAS fit is fairly simple. A model is used to construct an optical density
by taking into account all the physical effects the light entering the instrument undergoes.
This modelled optical density is then compared to the measured optical density. By varying
the physical parameters of the model (which include the trace gas column densities Si), the
difference between model and measurement are minimized. When the minimum is reached, the
physical parameters of the model are assumed to represent those of the measurement.

Due to noise in the measurement (see section 4.4.3), the modelled optical density can never per-
fectly match the measured optical density. Therefore, the DOAS fit searches for the minimum
quadratic deviation (dependencies omitted for readability):

χ2 =

[
ln

(
I0 + IOfs

I

)
−R−

∑
i

σi · Si −
∑
k

bkλ
k

]2
(4.6)

The unexplained remainder of the spectrum after minimisation (by varying the parameters Si

and bk) is called the fit residual. The smaller the residual, the better the fit has succeeded in
modelling the trace gas absorption. Ideally, the residual is only composed of noise. In order
to detect a trace gas, its optical density needs to be larger than the residual. This criteria can
be used to estimate the detection limit for a particular species. Once the minimum was found,
the fit parameters Si represent the column densities of the individual trace gases.

4.3 Calculating trace gas concentrations

Depending on the measurement geometry, the column densities obtained with the evaluation
described above need to be interpreted in different ways. One way is the assumption of simplified
geometrical approaches (like in this experiment as described in the following sections), but in
more complex cases, extensive radiative transfer simulations have to be carried out (section
4.3.4). The observation geometry can be described by the solar zenith angle (SZA) θ (angle
between the zenith and the sun) and the telescope elevation angle α (angle between the horizon
and the viewing direction). The light path also depends on the solar relative azimuth angle
(SRAA), which is neglected here.
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Figure 4.5: Light path through the atmosphere in the case of small (left) and large (right) solar
zenith angle. With larger SZA, the light path through a stratospheric absorber is enhanced.

4.3.1 Active measurements

Active measurements are measurements with an active or artificial light source. In modern ap-
plications, often LEDs are used because of their well defined spectra. For active measurements,
the interpretation of the retrieved column densities is the simplest, because the light path is
clearly defined. It runs from the light source to the DOAS instrument. Dividing the column
density by the length of the light path directly yields the average trace gas concentration along
the light path. There are some similar applications, where the instrument points directly at
the sun or the moon (direct light measurements).

4.3.2 Zenith sky measurements

Zenith sky measurements are performed by looking straight up with a passive instrument. In
this geometry, the exact light path is unclear, but radiative transfer models can be used to
make a statistical prediction about the average path. In order to compare different SCDs
(which depend on the light paths), one can calculate the Vertical Column Density (VCD or V )
from the SCDs with the help of the so-called Air Mass Factor (AMF or A):

AMF = A(θ) :=
S(θ)

V
≈ 1

cos(θ)
(4.7)

This approximation for the case of zenith sky measurements (valid for θ < 75) is illustrated in
figure 4.5. The Fraunhofer reference is typically taken at the minimal solar zenith angle around
noon. Therefore, the retrieved column densities are all relative to this value. The total SCD is
the sum of the ∆S and the column density already present in the Frauhofer spectrum SF .

S = ∆S + SF (4.8)

SF can be extracted with the help of a Langley Plot.

Langley plot

In a so-called Langley Plot, the measured ∆SCD is plotted as a function of the air mass factor
AMF. If the concentration of a measured trace gas is constant during the course of the day the
correlation between the ∆SCD and the AMF will be linear:
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V =
S(θ)

A(θ)
(4.9)

=
∆S(θ) + SF

A(θ)

⇒ ∆S (A (θ)) = V · A (θ)− SF (4.10)

Here, θ is the solar zenith angle. If a constant concentration is assumed, the resulting plot
can be extrapolated to A = 0. Here, ∆S = −SF , and the column density in the Fraunhofer
reference spectrum can be retrieved (see figure 4.6). Note that the assumption of a constant
concentration is only valid for a few atmospheric absorbers, e.g. stratospheric ozone.

Figure 4.6: Two examples of Langley Plots. The left panel depicts the Langley Plot of an ozone
measurement. Extrapolation yields a Fraunhofer SCD of approximately 1019 molec/cm2. The
panel on the right is a Langley Plot of a nitrogen dioxide measurement. Here, the concentration
is not constant during the course of the day, and the extrapolation does not yield a definite
value.

4.3.3 Multi-Axis-DOAS

The method of multi-axis DOAS (MAX-DOAS) strongly enhances the sensitivity for trace
gases located in the troposphere (for details, see [13]). When observing light with small eleva-
tion angles α (angle between the horizon and the viewing direction of the instrument), the light
paths through the lowermost atmospheric layers (and the SCDs of trace gases present there) are
strongly enhanced, as shown in figure 4.7. However, the light path through the stratosphere
does not change with elevation angle α. This offers the opportunity to distinguish between
stratospheric and tropospheric trace gases. This usually means recording the Fraunhofer ref-
erence spectrum in the zenith direction to minimize the light path through the lower layers of
the atmosphere. The airmass factor of a trace gas near the surface measured at an elevation
angle α can be approximated by:

A(α) ≈ 1

sin(α)
(4.11)

However, light paths can become very complicated. For very small elevation angles, parts of the
observed light are scattered within the trace gas layer. Multiple scattering can occur for high
aerosol loads and under cloudy conditions. The geometric approximation (equation 4.11) is not
valid anymore under these conditions. An example of MAX-DOAS measurements is shown in
figure 4.8.



22 CHAPTER 4. DOAS

Zenith

Troposphere

Scattering

�

Tropospheric
Absorber

Stratosphere

Figure 4.7: Observation geometry of MAX-DOAS measurements.
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Figure 4.8: NO2 SCDs measured with a MAX-DOAS instrument in Heidelberg. Different colours
indicate different telescope elevation angles. The SCD increases with decreasing elevation angle,
indicating the presence of NO2 near the surface. The U-shape of the diurnal profile is caused
by stratospheric NO2.

4.3.4 Complex scenarios

In case of heavy aerosol loads, clouds and more complex measurement geometries, such as from
satellites, aircraft and ships, the approximations described above are no longer useful, because
the light path distributions can become very complex. For example, figure 4.9 illustrates two
basic cases for cloud influence on light paths. Light path distributions can be simulated by
radiative transfer models (figure 4.10). A Levenberg-Marquardt algorithm [17, 18, 24, 25] then
searches for minima in a χ2 landscape to retrieve radiative transfer model parameters (e.g.
aerosol load and trace gas concentrations) that best represent measured slant columns on the
one hand and knowledge about the atmosphere on the other hand. Examples of this approach
can be found in e.g. [8, 9, 14, 23, 33].
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Figure 4.9: Left: for clear sky, sun light is scattered by air molecules and aerosol particles
towards the instrument. Center: diffusing screen effect: in the presence of thin clouds, a
substantial fraction of the observed photons is scattered by the cloud; especially for the smaller
elevation angles, this effect leads to an increase of the absorption path. Right: for optically
thick and vertically extended clouds, multiple scattering can lead to a very large increase of the
photon paths inside the clouds. [34]

Figure 4.10: Three different perspectives of events simulated by McArtim, a 3D backward trajec-
tory monte-carlo radiative transfer model, when observing a cumulus cloud at 670 nm. Green
points represent cloud and aerosol particle scatter events, blue points depict absorption events.
Ground scattering is shown in yellow and red dots symbolize Rayleigh scattering by air molecules
and hint to the lines of sight of the instrument. [6]

4.4 Background and noise

The spectra are collected by grating spectrometers with CCD detectors. The properties espe-
cially of the detectors have to be taken into account in order to correctly record and process
the spectra.

4.4.1 Electronic offset

The offset is an electronic signal (e.g. an analogue voltage or current) which is added to the
photon induced signal of each pixel for every exposure, because the AD-converter can not
convert a negative input. The offset can therefore best be measured by recording an exposure
at a very low exposure time with no light entering the spectrometer, as the measured signal
will then consist almost exclusively of the offset signal. To minimize the noise, however, it is
best to record many such scans in succession. For the Ocean Optics USB2000, e.g., typically
10000 scans at 3 ms (minimum exposure time of this spectrometer) exposure time are recorded
(figure 4.11, left panel). As the offset is added to each scan, the resulting spectrum must first
be scaled to the measurement spectrum by the number of scans before it is subtracted:
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IOS(n) = I(n)− NMeas

NOS

·O(n) (4.12)

Here, I(n) is the intensity measured at each pixel n, O(n) is the electronic offset, and N is the
number of scans with which the respective spectra were recorded.
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Figure 4.11: Left: Offset spectrum recorded with an Ocean Optics USB2000 spectrometer. Most
pixels have an average offset of about 221 counts/scan. For a typical measurement with sat-
uration 75%, this is approximately 7% of the measured signal. Right: Dark current spectrum
recorded at an exposure time of 60 seconds with a USB2000 spectrometer. Most pixels register
a dark current of less than 4 counts per second, but a few so-called hot pixels register much
more.

4.4.2 Dark current

The dark current is caused by thermally excited electrons which pass the semiconductor band
gap due to Boltzmann statistics. Therefore, it strongly depends on the temperature of the
detector. In many spectrometers, the detectors are cooled to keep the dark current low. This
is especially important for modern UV-sensitive back-thinned detectors, as the dark current is
very high otherwise.
For a constant temperature, the dark current signal is proportional to the exposure time.
To measure the dark current it is therefore best to use a long exposure time and only one
exposure, so the offset is only added once. Of course no light should enter the spectrometer
during the measurement. For the USB2000, the maximum exposure time is 60 seconds (figure
4.11, right panel). After the measurement is recorded, the offset must be corrected and the
remaining signal is the dark current. When correcting for the dark current of a measurement
spectrum, the measured dark current must be scaled to the measurement exposure time before
it is subtracted:

IDC(n) = I(n)− tMeas

tDC

·DOS (4.13)

Here, I(n) is the intensity measured at each pixel n and DOS is the measured dark current
after correcting for the electronic offset. Before subtracting it, it is multiplied by the ratio of
the measurement exposure time and the dark current exposure time.
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4.4.3 Noise

Two spectra will never be perfectly identical, even if they are recorded under identical condi-
tions. The reason for this is statistic noise in the photon signal and the detector background
signal and additionally systematic noise. The statistic noise can be quantified. A measurement
spectrum I = IB + IP is always composed of the background IB and the signal induced by the
incident photons IP . If multiple spectra are recorded under identical conditions, both contri-
butions will fluctuate around a mean value. Gaussian error propagation yields the following
equation for the total noise σ:

σ =
√

σ2
B + σ2

P (4.14)

The background noise σB is a property of the instrument and is therefore often referred to as
instrument noise. It is composed of fluctuations in the electronic offset and the dark current.
The photon noise σP is a fundamental physical phenomenon. For a given light intensity, the
number of photons in a certain time interval fluctuates. The number of registered photons is
then distributed according to the Poisson distribution: If M photons are registered on average
for a given time interval, the root mean square (RMS) of the obtained distribution will be

√
M .

Spectroscopy instruments are designed so that the photon noise, not the instrument noise limits
the instrument precision (see figures 4.12 and 4.13).

To measure both the instrument and the photon noise, two spectra I1 and I2 are recorded in
quick succession, so the magnitude of the noise contributions in the two spectra can be assumed
to be equal. If the two spectra are then subtracted from each other, the noise of the difference
σD calculates to:

σD =
√

σ2
I1
+ σ2

I2
(4.15)

=
√

2σ2
I (4.16)

⇒ σIi =
1√
2
σD (4.17)

Note that this is the average noise over all pixels. The instrument noise can vary 20-30 %
from pixel to pixel in modern CCDs [27]. In order to be entirely precise one would therefore
have to characterise the instrument noise of each pixel separately, but since under reasonable
measurement conditions photon noise largely dominates the overall noise in a spectrum, it is
not necessary to deal with this ’noise of the instrument noise’. When collecting more and more
light, at a certain point all statistical noise is so small that only systematic noise remains in
the residual.
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Figure 4.12: Noise measurements of a modern DOAS spectrometer. All statistical noise can
theoretically be reduced indefinitely by adding up more photons (scans), but at a certain point
systematic noise remains. [10]

Figure 4.13: Calculation of the statistical noise contributions in a single readout of a modern
CCD for different saturations. Photon noise is the largest statistical noise source for saturations
> 5 %. [27]
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4.5 Summary

Each measured spectrum is composed of several superimposed signals:

1. Background. The background signal is the measured signal when no light enters the
spectrometer (section 4.4):

� Electronic offset : Proportional to the number of scans recorded.

� Dark current : Proportional to the exposure time.

2. Narrowband effects (section 4.2.1)

� Fraunhofer spectrum: The Frauenhofer spectrum is the spectrum of the sun as it
arrives at the top of the earth’s atmosphere. It already contains many very strong
absorption structures. These are caused by light absorption by species in the sun’s
outer layers (photosphere).

� Trace gas absorption: Trace gases in the atmosphere create characteristic absorption
structures in the measured spectra. The goal of the DOAS retrieval is to identify
and isolate these structures, which typically feature optical densities between 10−3

and 10−1.

� Raman scattering : Inelastic scattering filling in Fraunhofer lines.

3. Broadband effects (section 4.2.2)

� Broadband absorption cross sections

� Rayleigh & Mie scattering : Elastic scattering either by air molecules (Cabannes line
of Rayleigh scattering) or by small water droplets or particles called aerosols (Mie
scattering).

� Spectrometer stray light (section 4.2.4)

4. Noise (section 4.4.3)

� Instrument noise: Proportional to offset and dark current.

� Photon noise: The noise of the number of photons at a given light intensity. Follows
Poisson statistics.

� Systematic noise: Sources for systematic noise can be unexplained physical changes
in the instrument or in the atmosphere. Can you think of some sources of systematic
noise in this experiment?

The optical density τ calculated from two spectra I and I0 is then fitted with the least squares
method according to equation 4.6. The resulting slant columns S can be converted to vertical
columns and concentrations with knowledge about the light path, see section 4.3.
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Experimental setup

This experiment is conducted at the Institut für Umweltphysik (INF 229), Room 238. During
the course of the measurements, the spectra of scattered sunlight as well as those of some
artificial light sources will be examined. In both cases, a telescope is used to collect the light.
For the atmospheric measurements, a telescope mounted on the roof of the building is used
(see figure 5.1). For the laboratory studies, another telescope mounted on an optical bench is
employed (figure 5.2).

5.1 General setup

The respective telescope is connected to the spectrometer with a 400 µm diameter quartz fibre
bundle with a numerical aperture of 0.22 and protected by a metal tube. The quartz fibre is
easily damaged, so please handle it with care. The fibres of the spectrometers can either be
connected to the roof telescope fibres or to the lab telescope by couplings.
The spectrometers are located in a metal housing. This housing contains thermoelectric cool-
ing units which are used to stabilize the spectrometer temperature. The data recorded by the
spectrometer is sent to a PC via the USB interface. Figure 5.2 gives an impression of the
instrumentation.

5.2 The spectrometer

The commercial miniature spectrograph-detector unit Ocean Optics USB2000 represents the
heart of the DOAS instrument. It is built in the Czerny-Turner design (see Figure 5.3).
The light entering the spectrometer through a slit is collimated by a spherical mirror and
projected on a grating as a parallel light beam. The grating disperses the light into its spectral
components. A second spherical mirror focuses the light on a detector, which consists of a
one-dimensional CCD array with 2048 pixels.
The most important features of the detector are:

Number of pixels: 2048
Pixel size: 14µm× 200µm
Full Well Capacity per pixel: 100 000 electrons
A/D - Converter: 12 Bit (i.e., 4096 Counts/Pixel)
Integration time: 3 ms - 65 s
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Figure 5.1: Telescopes to collect scattered sky light.

Figure 5.2: Laboratory instrumentation.
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Figure 5.3: The USB2000 spectrograph with detector. 1: fibre connector; 2: entrance slit; 3:
optical filter; 4: collimating mirror; 5: grating; 6: focusing mirror; 7: collection lens; 8: CCD
detector.



Chapter 6

Software

This chapter describes which software is to be used to complete the experiment. The computer
in use runs on a Windows 10 environment for evaluation and internet access, while the mea-
surement system is a Windows XP virtual machine. This is required for the software DOASIS.
You can choose to evaluate your data either with ORIGIN or use your own programs with
Python.

6.1 DOASIS

In this experiment, all data acquisition and evaluation is performed with the program DOASIS
(DOAS Intelligent System), which was developed at the Institut für Umweltphysik in the scope
of a PhD thesis.
DOASIS can be used to acquire data from the spectrometer and display it in a graphic user
interface for evaluation. The program is written for Microsoft Windows, uses a typical Win-
dows interface, and should therefore be easy to learn. When conducting measurements and
performing data evaluations ’by hand’, all functions are accessed via the menus at the top of
the window. However, all functions can also be called from jscript programs. These scripts
allow the automation of data acquisition and evaluations.
The DOASIS user interface is split into 4 areas, as shown in figure 6.2.

� Spectrum Sheet : This area is used for viewing the spectra. You can switch between all
open spectra by clicking on the tabs at the top of the spectrum sheet. The y axis is
automatically scaled to fit the displayed spectra. You can zoom in to any part of the
spectra by holding the left mouse button down and dragging the mouse.

� SpecBar : You can use the Specbar to switch between open spectra. Alternatively, this
window can be used to control the spectrometer by clicking on the PDA tab.

� Information window : This area gives you information on the current spectrum. You can
switch between Statistics such as maximum, minimum, average and standard deviation
(called Deviation) and Properties such as exposure time and number of exposures.

� Console: The console can display different things, depending on which tab you select:

1. Output gives you information about called functions or running scripts.

2. Script is used to start, stop and edit scripts.

3. Mini Scripts can be used to quickly implement small scripts.

4. Quickscript allows the user to define shortcuts to certain scripts.

5. Fitting is used to run DOAS retrievals.
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First steps

1. Record a scattered light spectrum.
To do so, change from the Specbar register to PDA. Set the Device to Ocean Optics USB
2000, if this has not been done yet. Below, you can set the spectrometer’s exposure time
in milliseconds and the amount of exposures to record (NumScans), see figure 6.1. Start
the measurement by clicking on the Scan button.

2. Check the information DOASIS gives you.
In the Information window under the register Statistics you will be given statistical
information about the current spectrum such as the average number of counts (Average),
the standard deviation from this value (Deviation) and the maximum number of counts
(Max ). Also take a look at the Properties register.
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Figure 6.1: Left side: In the PDA Register you can set the exposure time and number of
exposures. Right side: The Properties register contains useful information about the current
spectrum.

3. Record further spectra.
In order not to overwrite your first spectrum, use the menu command File → New...
to open a new Spectrum Sheet. Play around with the exposure time and the number of
exposures. Record an oversaturated spectrum. (Each pixel has a single exposure full well
capacity of 212 − 1 = 4095 Counts.

4. Compare two spectra with each other.
Use the menu command View → Add Overlay... to view two spectra on top of each other.
If you use the option Fit all overlays, the y axis of the overlay spectrum will be adapted
so that both spectra are fully visible on the screen.

5. Zoom in to an area of the spectrum.
Hold the left mouse button down while drawing a rectangle around the area of interest.
The program will then zoom in to this area. Notice that the Statistics in the lower right
corner of the screen also change. They now give information about the zoomed in region
of the spectrum. Click the right mouse button on the Spectrum Sheet to zoom back out.
Note, that the zoom rectangle should be drawn from left to right. Dragging from right
to left occasionally causes errors.
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6. Save your spectrum.
First, create your own folder in the directory

FPDaten\FP\FP− Praktikanten\

and save all your files into this folder (except for special cases, which are noted in this
script). If you save your files somewhere else, they will be deleted.
Open the save dialog using File → Save As.... DOASIS supports a number of file formats.
The standard format is *.sp2. In this format, all spectrum properties are saved, and this
is the format you should use during the experiment. However, if you wish to plot a
spectrum using Origin, you will need to save it as a text file. Try this now and use the
*.txt format to save your current spectrum.

6.2 Python

We assume you have some prior knowledge about Python and basic experience. You will not
need to be exceptionally crafty, but you should be able to read data, make some basic calcu-
lations and plot them. For the evaluation of part 7.3.2, there is a script given in the C:\Users
FPDOAS\Documents\FP\aktuell\\Quicklook folder. Use it either as a Python Notebook or
(recommended) with Spyder. You can start both softwares via the Anaconda Navigator.
To use the script,

� Save your output files from AutomatischeAuswertung.js in the same folder as the quick-
look.py script

� Open the script and change the variables in the ”CONSTANT NAMES” section to your
output file names and the cross-section names of the fit (the file names of the convolved
literature cross sections from 7.2.1)

� Run the script to have a look on your data - you should observe a U-shaped evolution
over the course of the day for both ozone and NO2.

For all following tasks, I recommend using the Python package pandas as in the script we
provide. Feel free to copy everything, especially the ”Load Data” part.

6.3 Origin

Origin is a plotting and data analysis software similar to Microsoft Excel but with some added
capabilities useful for scientific data preparation. The most important functions are:

� Import Data: File → Import → Single ASCII...

� Create a plot:

1. Select the X-axis: Select a column with the mouse, click the right mouse button on
it and select Set As → X.

2. Repeat the above step for the Y-axis. The Y-axis column must be to the right of
the X-axis column.

3. Select the columns to be plotted by holding the CTRL key and selecting the multiple
columns.
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Figure 6.2: The graphic user interface of DOASIS is split into 4 areas.
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4. Now click the right mouse button on them and select Plot → ...

� Change the axis labels: Right click the labels and select Properties...

� Export a plot to a jpeg or other format: File → Export Page...

� Add a new column: Column → Add New Columns...

� Fill a column with values calculated from another column: Right click on an empty
column, select Set Column Values.... The letter ’i’ can be used to represent the respective
row number.

First steps

1. Import your spectrum.
Use the menu entry File → Import → Single ASCII.... If the imported data has the wrong
order of magnitude, use the Import Assistent instead and change the decimal marker.

2. Create a plot.
Select the two columns you wish to plot and click the right mouse button on them. Use
the menu entry Plot → Line

3. Label the axis.
Click the right mouse button on X Axis Title and choose Properties.

4. Export the plot.
Use File → Export Page... to export the plot in a format you can later use in your report.
Save your files in your own directory in

FPDaten\FP\FP− Praktikanten\

If you save your files somewhere else, they will be deleted.



Chapter 7

Course Instructions

Please do NOT change the computer’s time!

The quartz fibre is very sensitive! Do not forcefully bend it or it will break!
The computer should be switched on and automatically record spectra. Stop the automated
measurements by clicking on the Script register on the bottom left corner of the screen, then
click on the Stop button. The program will finish the current measurement, which may take a
few minutes. If the window Terminate Script pops up, click No.
When you have familiarized yourself with the experimental setup and evaluation software, you
can begin the experimental part of the course. The first measurements will take place in the
lab room. Therefore, CAREFULLY unlock the fibre coupling. Do not touch the end of the
fibre (because of fat and liquid on your skin). In order to record dark spectra, use a tissue,
towel or something similar instead.

7.1 Characterizing the instrumentation

When recording a spectrum, two parameters must be taken into account: the exposure time
and the number of exposures, also called scans. The exposure time is usually given in mil-
liseconds and represents the time the detector is exposed to incoming light. The number of
scans (called NumScans in DOASIS) tells the spectrometer how many exposures to add for
each measurement.
It is important to use the dynamic range of the instrument’s detector (see figure 4.13). If the
exposure time is chosen too short, the recorded spectrum will consist almost exclusively of
electronic offset and the noise pattern will be large. On the other hand, if the exposure time is
too long, the detector will be oversaturated and the top of the spectrum will be cut off. Why
should either situation be avoided?

The saturation T of a detector pixel P is defined as:

T (P ) =
C(P )

N · Cmax

· 100 (7.1)

Here, C(P ) is the number of counts registered in the pixel, N is the number of scans. Cmax =
4096 is the maximum number of counts the pixel can register. At saturations above 80%, the
sensitivity of the CCD detector begins to drop off. Therefore, the measured signal is no longer
proportional to the incoming photons. To avoid this, a saturation of about 70% is typically
used for atmospheric measurements.
In this section you will learn about the composition of a measured spectrum and how to optimize
your measurements. The spectrometer’s detector is of special importance in this respect.
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7.1.1 Offset

1. Record an offset spectrum.
Cover the fibre so no light enters the spectrometer and record an offset spectrum. You
should use at least 10,000 exposures at the minimal exposure time. Save the spectrum in
the *.sp2 format.

Determine the mean offset value per pixel per scan. Use the Statistics tab and if nec-
essary the menu entry Math → Scalar Operations → . . .

7.1.2 Dark current

1. Record a dark current spectrum.
Use the maximum exposure time of 60 seconds. One exposure is enough here. Save the
spectrum.

Do you need to correct for the offset here? If so, use the menu entry Math → Cor-
rect Offset 1 and then save the spectrum again. Determine the average number of counts
per pixel per second caused by dark current and compare this value to the offset.
Discuss the relevance of the dark current correction.

2. Record at least 5 further dark current spectra at smaller exposure times.

Is the dark current constant? Plot the average dark current signal against the exposure
time.

When correcting your measurements for offset and dark current, the Correct Offset and Correct
Dark Current functions in DOASIS will automatically deal with the calculations from chapter
4.4.1 and 4.4.2, which means you do not need to worry about the relative number of scans or
exposure time of your offset/dark current spectrum and the measurement you want to correct.

7.1.3 Determining the instrument noise and total noise

Instrument noise

1. Take 2 offset spectra (10,000 exposures) back to back and calculate the difference.
Math → Spectrum Operations → Subtract Spectrum. Determine the standard deviation
(see Statistics, Deviation)

How can the instrument noise of a single spectrum now be calculated?

2. Determine the noise for smaller exposure numbers.
Use at least 5 sets of 2 spectra that were recorded under identical conditions, and do the
above calculation.
How should the instrument noise depend on the number of exposures? Plot the instrument
noise against the number of exposures.

1 The commands ’Correct Offset’ and ’Correct Dark Current’ automatically correct for different ex-
posure times and number of exposures, so you do not need to do this by hand. However, it is important that
the Properties NumScans and ExposureTime of the offset and dark current spectra are correct when these are
saved.
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Figure 7.1: Instrument setup for recording halogen lamp spectra.

Total noise

1. Connect the fibre to the small optical bench for measuring light from the halogen lamp.
Maximize the light throughput into the fibre by adjusting the lenses on the bench until
you reach a saturation of about 60% for a small exposure time (< 100 ms).

2. Like with the offset spectra, record 5 sets of 2 lamp spectra each to determine how the
total noise depends on the number of exposures.
Correct both spectra for offset and dark current (Math → Correct Offset . . ., and Correct
Dark Current . . .).

3. Take the difference of each set of halogen lamp spectra. Determine the standard devia-
tion. This gives you the absolute total noise. If the lamp intensity drifted between the
two evaluated measurements, systematic structures (typically of the shape of the lamp
spectrum) will appear in your noise spectrum. In this case, a high pass filter has to be
applied: For this purpose create a copy of the noise spectrum (Edit → Duplicate) and
apply a low pass filter (Math → Filter → Low Pass Binomial, 1000 iterations). Subtract
this low pass filtered spectrum from your original noise spectrum. Now, most systematic
structures should be gone.

Compare the total noise and the instrument noise.

4. Now divide the two spectra by each other and take the logarithm. This will give you the
optical density of the relative total noise.

What do you expect the average value to be? Describe the dependence of the relative
total noise on the saturation level and on the number of exposures. What is the physical
explanation of the dependencies? Discuss the influence of the noise on the quality of
atmospheric measurements.

7.1.4 Calibrating the spectrometer

1. Place the mercury vapour lamp on the optical bench for stability. Record a spectrum of
the lamp at a good level of saturation (do not oversaturate the peaks!).

2. Correct for offset and dark current.
You can use a script to save some time. Click on the script tab (see figure 7.2) and select
the script Offset&DunkelstromKorr.js. Open it in the editor and check the paths in the
script. They should be set to FPDaten: \\FP \\Aktuell \\Korrekturspektren \\Offset.sp2
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Figure 7.2: The Script tab. Press the button Browse to open a script. The Edit button opens
the script in a text editor. Press Start to start the script.

and FPDaten: \\FP \\Aktuell \\Korrekturspektren \\Dunkelstrom.sp2. Please do not
change the script. Instead, save the offset and dark current spectra you measured over
the old ones at this location. Use the Quick Scripts tab next to the Script tab to link
the script Offset&DunkelstromKorr.js to the hotkey position F2. Whenever you want to
correct offset and dark current, you can now do so by simply pressing F2. This will start
the script.

From now on, all measured spectra must be corrected for offset and dark current!

3. Determine the Full Width at Half Maximum (FWHM) of the 4 largest mercury peaks by
hand. The FWHM gives the optical resolution of the spectrometer.

What is the optical resolution of the spectrometer? Is it constant for all wavelengths?

4. Determine the wavelength calibration.
Zoom in to a mercury peak and place the marker on the center of it (View → Markers →
show Marker). You may also derive the center with a gauss fit on the line. The Properties
window now gives you the channel number of the marker. Use figure 7.3 and the Data
Calibration Assistant (Data → Calibration Assistant) to perform the calibration. Use
a 2nd order polynomial. Why shouldn’t you use the peak at 313nm for the calibration?
When the calibration assistant finally asks, where the calibration polynomialshould be
applied, set ticks at all the available options. Write down the polynomial coefficients as
they appear in the Output window. From now on, your calibration will automatically be
applied to all recorded and generated spectra. To still have the opportunity to manually
recalibrate a spectrum, open the script Kalibrieren.js for editing and replace the old cal-
ibration coefficients with your new ones. Save the script and link it to the F3 key. You
can now add the wavelength information to any measured spectrum by pressing F3.
Note: The wavelength information displayed above the spectrum is not always accurate.
To get the accurate wavelength of a certain pixel, double-click in the spectrum to move
the Marker there and then click and hold the Marker. The accurate wavelength will be
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displayed at the upper end of the Marker, if you move the Marker around.

Determine the optical resolution of the spectrometer in nanometers.

Figure 7.3: Spectrum of the mercury vapour lamp recorded with the USB2000 spectrometer.

7.2 Laboratory Measurements

In this part of the course, you will prepare a reference cross section of NO2 and measure the
concentration of NO2 in a gas cell. You will learn how to run a DOAS fit.

7.2.1 Convolution of reference cross sections

The reference cross sections of the trace gases can be measured in the laboratory under con-
trolled conditions, and many research groups are specialized on such experiments.2 However,
because these reference measurements are typically measured at a much higher wavelength
resolution than used in the DOAS measurements, the references must first be adapted to the
resolution of the spectrometer used in this experiment. This is done by convolving the high
resolution reference cross-section with the DOAS instrument slit function. The slit function is
the signal measured by the spectrometer when a monochromatic light source is observed and
is a measure for the optical wavelength resolution of the instrument. The convolution smooths
the reference and removes high resolution structures that the DOAS instrument cannot detect
with its limited resolution.
The literature cross section is in units of [cm2], and represents the absorption of NO2 as a
function of the wavelength. It was recorded at a much higher resolution than our spectrometer
has. In order to use this high resolution cross section in a DOAS evaluation of our spectra, it first
needs to be smoothed to the resolution of our spectrometer. This is done by convolving it with

2A comprehensive database of relevant atmospheric species can be found at http://www.

uv-vis-spectral-atlas-mainz.org/

http://www.uv-vis-spectral-atlas-mainz.org/
http://www.uv-vis-spectral-atlas-mainz.org/
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the instrument point spread function. This function gives the optical resolution: it represents
the spectral line shape of monochromatic light when measured by a particular spectrometer.
In order to conduct this convolution, however, we first need to know the pixel - wavelength
calibration of the spectrometer.
What is the convolution doing mathematically?

1. Zoom in to the highest single mercury vapour line. Place the green Math Marker (View
→ Markers) over the line. To move the Math Marker, move the mouse to the lower rim
of the spectrum. An arrow will appear, which allows you to move the marker. Moving
the mouse to the sides of the green area will allow you to resize it. Mark the mercury line
so it is completely covered by the green area.

2. Place the Marker in the center of the mercury line, so that the area under the emission
line on both sides of the vertical black marker is the same.

3. Create a new Spectrum Sheet(File→ New...) with 2048 channels. This sheet will contain
the result of the convolution. It needs the spectrometer’s wavelength calibration
(F3)!

4. Open an NO2 literature cross section spectrum.
You will find literature cross sections in the folder Referenzspektren.

5. With NO2 opened in the spectrum sheet, select Math → Convolute.... The Convolution
Kernel is your mercury line. The Target is the new spectrum you just created which has
your wavelength calibration. Don’t use Auto search peak in kernel, but do use Normalize
convolution kernel.

6. At this point, call your experiment adviser to check that all settings are done correctly.
This may save you a lot of time.

7. Run the convolution. Compare the high resolution reference cross section with the convo-
luted cross section. How do they differ?

8. Save the convolved absorption cross section. I recommend a simple name like no2conv,
o3conv, ...

9. Repeat the above steps to convolute references for ozone, O4 and H2O. You will need
these references for the evaluation of the atmospheric measurements.
What is the effect of the convolution on these references?

7.2.2 Recording a spectrum of the NO2 gas cell

We will now hold a gas cell of length L into the light path between the halogen lamp and the
fiber. The Lambert-Beer equation 4.2 can then be written in a simplified form:

I(λ, L) = I0(λ) · exp(−σNO2(λ) · ρNO2 · L) (7.2)

I(λ) and I0(λ) can be measured directly in this experiment.

1. Record and save a well saturated spectrum of the halogen lamp without any gas cells
between the lamp and the fiber. How many exposures are required? Remember that you
want to evaluate for NO2, so make sure the saturation level of the spectrum is good in
the wavelength range you later want to do the evaluation in. Some parts of the spectrum
may be oversaturated ...
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2. Repeat the measurement, but this time place the gas cell between the lamp and the fiber.
Save your spectrum.

Using the 2 spectra you just recorded, you now can calculate the concentration of NO2 in the
gas cell. To do this, you will need the convoluted reference cross section of NO2 you prepared
in the previous section.

7.2.3 Determining the NO2 concentration in the gas cell

By directly applying the Beer - Lambert law of absorption, you can now calculate the NO2

concentration.

1. Correct your measured spectra for offset and dark current.

2. Divide the spectra by each other (Math → Spectrum Operations→ ...).

3. Take the logarithm (Math → Logarithm).

By performing the above steps, you have calculated the optical density τ from equation 4.5:

τ = ln

(
I0(λ)

I(λ)

)
= σNO2(λ) · ρNO2 · L (7.3)

Why is it unproblematic if the saturation or the number of scans of the two spectra is different?

σNO2 is the cross section of NO2, which you have prepared for this spectrometer. In order to
calculate the concentration ρNO2 , we will now perform a least-squares fit. This fit varies the
SCD such that χ2 in the following term is minimized (compare equation 4.6):

χ2 =

[
ln

(
I0(λ)

I(λ)

)
− SNO2 · σNO2(λ)−

∑
k

bkλ
k

]2
(7.4)

This step is done by the fit routine in DOASIS.

1. Select a reference cross section which you want to fit to the measured signal.
Click on the Fitting tab on the bottom of the screen (see figure 7.4). Double click on
a line Reference Name column to add a reference. The reference cross section spectrum
must be open in DOASIS.

2. Select an appropriate fit range. To do this, place the red Fit Marker (View → Markers)
over the area of the spectrum that you want to fit. The Fit Marker can be moved and
resized in the same way as the Math Marker.
When selecting a wavelength range for your fit, try to keep the following aspects in mind:

� As a general rule, the width of the fitting range should be < 50 nm.

� How is the saturation of your spectrum? Don’t include areas of the spectrum in
which the saturation is low.

� Where are the largest differential absorption structures of the trace gas you want to
evaluate?

� What other trace gases must be taken into account in this wavelength range? (In
this case, the gas cell only contains NO2, but in the atmosphere there will be several
trace gases which absorb simultaneously.)



7.2. LABORATORY MEASUREMENTS 43

To study these aspects, it can be helpful to compare your measurement with the reference
cross section. First, save your measurement. Then, run a high pass filter over it (Math
→ Filter → High Pass Binomial...) to remove broadband structures. Do the same for
the NO2 reference, and overlay the two spectra on top of each other. You should now be
able to clearly see the NO2 absorption in your gas cell. Find an appropriate fit range,
then use the Undo function to undo the filtering (alternatively you can reload your saved
spectra).
Once you have found an appropriate fit range, you can enter this directly into the Prop-
erties window (Marker → FitHigh, FitLow) or use the red Fit Marker (View → Markers
→ Show Fit Marker) to select a range and then click on Get in the Fitting tab to auto-
matically input the edges of the fit range into the fit scenario.

3. Select a DOAS-polynomial of 3rd to 5th order, in order to account for broad structures
like the intensity variation of the lamp. (You can also add an Offset polynomial to correct
for spectrometer stray light.)

4. Start the fit by clicking on the red exclamation button.

Figure 7.4: The Fitting tab. The references are selected in the column Reference Name. Press
Get to input the current edges of the Fit Marker into the fit settings. The exclamation point
starts the fit. The disk button below it can be used to save the fit settings in a Fit Scenario. Log.
spectrum takes the logarithm of the spectrum before doing the fit. It should be deactivated
here as you already have taken the logarithm!

After performing the fit, the fit coefficient for which the minimal χ2 was found is given in the Fit
Coeff. column of the Fitting register. Since the spectra were prepared according to the above
equations, the fit coefficient represents the column density ρNO2 ·L and the unit is molec/cm2.
The Shift value is the amount of pixels the spectrum was shifted to obtain an optimum fit, the
Squeeze value is the factor by which it was squeezed or stretched. These values should be close
to 0 and 1, respectively.
Now take a look at the Fit Residual spectrum and the obtained χ2 value.

What should Fit Residual look like in the case of an ideal fit?

Try varying the fit range. You can save the Fit Result page by using Print and selecting
Microsoft XPS Document Writer as Printer. (Deactivate the Print spectrum information but-
ton, since it takes up too much space on your plot.) This is very useful if you want to show
and compare the quality of your fits in your protocol or report.
When you have found the ideal fit range for this NO2 measurement, take two new spectra of
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the halogen lamp and the gas cell, but this time optimize the saturation level (to about 80%)
in this wavelength range. Rerun the fit.

Calculate the NO2 concentration and the mixing ratio (amount NO2 molecules per air molecule)
in the gas cell assuming normal pressure and temperature.3

If you leave the lab now, remember to CAREFULLY reattach the fibre coupling to the fibres
of the telescope on the roof. Check if the telescope points to the zenith, close DOASIS and
start the program Dauermessung on the Desktop.

7.3 Atmospheric Measurements

In this section you will use the techniques you have learned to evaluate atmospheric measure-
ment spectra recorded with this experimental setup. The instruments typically run in a zenith
viewing direction, and it will be your task to evaluate the spectra from past measurements.
First, you will evaluate ozone, then NO2. For each species, you will calculate slant column den-
sities as well as vertical columns. The approach will be to first evaluate a single measurement
by means of which you will optimize the fit settings. These settings will then be saved in a Fit
Scenario and will then be used to automatically evaluate the other spectra of that day. The
final product of the evaluations will be a time series of the vertical and slant column densities
for the entire day.

7.3.1 Configuring the fit with a single measurement

1. Pick a day to evaluate. The spectrometer usually runs all the time in zenith observation.
You find the spectra in FPDaten:\FP\Daten\Streulicht. Choose a summer day with a
few hundred spectra and store all spectra in the FP\aktuell\Streulicht folder. Delete
all spectra previously stored there. Find a midday (Fraunhofer reference) and evening
spectrum from the day you wish to evaluate. To do this, open the logfile of your date in the
FPDaten:\FP\Logfiles folder to find the Fraunhofer reference. The reference spectrum
is the spectrum recorded at the smallest solar zenith angle. Write down the spectrum
number of this spectrum. Also find a spectrum recorded in the evening at a solar zenith
angle close to 80° and write down the spectrum number. Open these two spectra, correct
them for offset and dark current, and save them in your directory. If no logfile is available,
have a look on the recording time of the spectra - this gives you a good hint on the solar
zenith angle (SZA) at the time of recording. You can see the SZA in the Properties tab
in DOASIS under ScanGeometry and then iterate to the reference spectrum. Note that
the time stamp is UTC (consider this when choosing the starting time for your search).
Why is it advantageous to use a spectrum with a high solar zenith angle to optimize the
settings for your fit?

2. Calculate the Ring Spectrum.
Open the Frauenhofer reference and add your wavelength calibration. Then use the menu
entry Math → Ring Spectrum to calculate a Ring spectrum. Save the obtained spectrum.
It will be used in the fit procedure to correct for the Ring effect.

3. Tip: Go back to the scattered light spectra. Make a copy of the evening spectrum, divide
it by the Fraunhofer reference and calculate the optical density by taking the logarithm.
You should now be able to see the structured absorption lines of ozone in the lower
wavelength range, and probably also of NO2 in the higher wavelength range. This should

3Avogadro’s constant = 6.022 · 1023 Mol−1, Molar volume = 22,4 l
Mol
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give you a good idea of the wavelength ranges where you can do the fit (see item 5 below).
Save your optical density spectrum.

4. For the automated retrieval however, go back to your Fraunhofer reference and take the
logarithm. Save this spectrum. Instead of dividing by the Fraunhofer reference, we will
now include the logarithm of this spectrum as a reference cross section in the fit. It needs
to be input as the first fit reference in the fit scenario.4

5. Include your Ring spectrum in the fit scenario and link shift and squeeze of the Ring
spectrum to the reference. Then open all convolved trace gas cross sections and include
them in the fit scenario. It is advisable to link the shift and squeeze of all trace gases
together (for example, link the shift and squeeze of NO2 and O4 to O3).

6. Make sure, the ’Log. Spectrum’ option on the right is left open at any time. We take the
logarithm of the measurement spectrum by hand later. Also the evaluation script takes
the logarithm of the measurement spectra automatically.

Why is this helpful to get realistic results?

7. Find appropriate wavelength ranges for ozone and for NO2.

What are the criteria for finding these fit ranges?

Use the overlay function of DOASIS to compare your optical density spectrum to the
individual reference cross sections of ozone, NO2, H2O and O4. Try to avoid wavelength
regions in which the H2O absorption is prominent, as removing these structures can be
tricky.

8. Once you have found appropriate fit settings, select the evening spectrum in the spectrum
sheet, take its logarithm and start the fit. Remember to include the reference cross
sections of any species absorbing in your fit range as well as the Ring spectrum. Compare
your fit scenario with equation 4.6 and identify all terms, including the polynomials.

9. Review the fit results. Ask yourself the following questions to assess the quality of the fit:

� What does the fit residual look like?

� Were the traces gases included in the fit identified?

� What is the χ2 value?

10. Play around with the fit settings until you are content that the configuration is correct
and the fit quality is good.

11. Save your final fit settings in a Fit Scenario by clicking on the disk button below the
exclamation point. Use the path FPDaten:\FP\aktuell. Check for a very last time,
that the ’Log. Spectrum’ option is left open before saving the fit szenario!

4Mathematically, fitting the logarithm of the Fraunhofer reference is the same as dividing by it as can be
shown in the Beer-Lambert law (equation 4.4), except for one small difference: The fit now allows the spectrum
to be slightly shifted against the measurement spectrum. This can be useful if the spectrometer’s wavelength
calibration is not perfectly stable during the course of the day. Strictly speaking, the fit coefficient of the
logarithm of the Fraunhofer reference can be fixed to 1 (or -1, depending on the setup of the fit scenario). The
automated retrieval script monitors the fit coefficient of the first reference spectrum, and gives a warning if it
is not close to 1.



46 CHAPTER 7. COURSE INSTRUCTIONS

7.3.2 Automated evaluation of an entire day

Now you will evaluate the spectra from the entire day using the settings you found for the
evening spectrum. The script AutomatischeAuswertung.js in the directory
FPDaten:\FP\Daten\Scripts will help you. It uses your offset and dark current spectra to
correct each individual measurement spectrum, then uses your Fit Scenario to subsequently
run the fit for each spectrum. The fit results are stored in a text file.
The ozone evaluation is somewhat easier than the NO2 retrieval. Therefore, it is best to start
with ozone. Also, plot the fit results for ozone and make sure they are reasonable before starting
the NO2 evaluation. Reasonable means that you observe a U-shape. To plot the time series,
you can either use the Python script or ORIGIN.

1. Before you begin the automated retrieval, make sure your offset and dark current spectra
are saved as Offset.sp2 and Dunkelstrom.sp2 in the directory
FPDaten:\FP\aktuell\Korrekturspektren. Also, your Fit Scenario needs to be in the
directory
FPDaten:\FP\aktuell and all spectra to be evaluated in FPDaten:\FP\aktuell\Streulicht.

2. Start AutomatischeAuswertung.js. The script will ask you for the following input: 5

� First, the script tells you to recheck your offset, dark current and fit scenario files.
As you have already done this click the mouse in the next free line in the output
window and press ENTER.

� Now the script asks for the name of your Fit Scenario. Type in the file name, but
do not include the file extension *.fs. Press ENTER.

� Finally, the script asks for a name for the result text file. Choose a name with less
than 8 characters, only include lower case letters and numbers and don’t include a
file extension. Press ENTER.

If all the information was entered correctly, the script now runs the evaluation. The χ2

values are displayed in the output window along with any warnings that may occur.

3. Once the evaluation has finished, you can import your result file stored in
FPDaten:\FP\aktuell into Origin or Python. Create the following plots:

� Time series of the slant column density (SCD) for ozone and NO2

� Langley Plot for ozone

� Time series of the vertical column density (VCD) for Ozone in Dobson Units6

What should the time series of ozone SCDs look like? What about the VCD time series?

What is the main difference between the ozone and NO2 time series, and what causes
this difference?

If you leave the lab now, remember to CAREFULLY reattach the fibre coupling to the fibres
of the telescope on the roof. Check if the telescope points to the zenith, close DOASIS and
start the program Dauermessung on the Desktop.

5WARNING: This script closes all open spectra in DOASIS, so be sure to save your data first. Also, the
input window unfortunately does not accept the BACKSPACE or DEL keys. If you make a typing mistake you
will need to start the script again from the beginning.

61 DU = 2,6 ·1016molecules
cm2 .
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7.4 Multi Axis DOAS (MAX-DOAS)

The MAX-DOAS technique is used to gain insight into the vertical distribution of trace gases
in the atmosphere. To this extent, scattered light spectra are recorded using different telescope
elevation angles.

7.4.1 Recording scattered light spectra at different elevation angles

If possible, you should record 4 sets of MAX-DOAS measurements. Each set consists of three
measurements at different telescope elevation angles. These three measurements should be
conducted in rapid succession if possible. Why is this important? Make sure that the telescope
is clean and that there is no water or ice in the tube:

� Measure a spectrum at 7° elevation.

� Measure a spectrum at 12° elevation.

� Measure a zenith spectrum at 90° elevation.

Use the metal plate mounted on the telescope to adjust to the different elevation angles. Even
though the telescope needs to be readjusted very often, please record the MAX-DOAS mea-
surements in the order mentioned above: 7°, 12°, 90°, 7°, 12°, 90°, 7°, ... Be sure to adjust the
exposure time of the spectrometer to obtain an appropriate saturation level for each individual
spectrum. The individual spectra do NOT need to be recorded at the same exposure time.
Take about 1000 exposures per spectrum. Note the weather conditions during the measure-
ments to be able to better interpret your data later.

7.4.2 MAX-DOAS evaluation

1. Use the respective 90° spectra as your Fraunhofer reference spectrum for each set. Perform
the necessary corrections and calculate a Ring spectrum.

2. Evaluate the individual MAX-DOAS spectra for ozone, NO2, and O4.

3. Plot your results with Origin. How do the SCDs of the individual species depend on the
telescope elevation angle? How do they depend on the reference?

7.5 Before you leave...

� Adjust the telescope to the zenith position

� Close DOASIS

� Start Dauermessung on the Windows XP Desktop by double-clicking it.

� Remove any files you have added to FPDaten:\FP\aktuell and put them in your own
folder for later reference.



Chapter 8

Course Report

Be sure to include the following points in your course report:

1. Characterizing the instrumentation

� Offset and dark current (give average values)

� Plot the dark current signal as a function of the exposure time. Is the dark current
stable?

� Plot the instrument noise and the total noise as a function of the number of exposures

� Plot the noise of the optical density as a function of exposures

� Compare the instrument noise to the total noise

� Determine the wavelength calibration and the optical resolution of the spectrometer

2. Gas cell measurements

� NO2 concentration in the gas cell

� NO2 mixing ratio in the gas cell

3. Differential slant column densities for O3 and NO2

� Plot ∆SCD for ozone and NO2 as a function of time of day

� What should these plots look like? Explain why.

� Do these plots match your expectations? Give possible explanations for any discrep-
ancies.

4. Langley Plot for ozone

� Langley Plot: ∆SCD as a function of Air Mass Factor (AMF) for AMF < 5.

� Determine the ozone reference slant column density SCDref in the Fraunhofer refer-
ence by extrapolating the Langley Plot for AMF < 3.5. Also estimate the error of
this value by determining a maximum and minimum possible extrapolation in your
data.

5. Plot the time series of the ozone vertical column density (VCD) over the course of the
day. Include error bars. Compare your VCD to ozone data from satellite measurements.
This data can be found at http://ozoneaq.gsfc.nasa.gov. Heidelberg is at longitude
8.49 and latitude 49.29.

48
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6. MAX-DOAS

� Plot the ∆SCD as a function of the telescope elevation angle for ozone, NO2 and O4

for each set and compare the measurement sets.

� Which of these trace gases were found in the troposphere, which were only seen in
the stratosphere?

� Can you see the influence of clouds in your O4 measurements?

Please include a critical discussion of your results. Include possible explanations for unexpected
results.
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